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Chapter 1

Introduction

GNUBatch is a fully functioned, high performance Job Scheduler and Management System which is avail-
able for a wide range of machines running a Unix-style Operating System.

The product consists of a “core product“ or “basic product” which contains the scheduling software,
command-line and character-based interfaces. Additional options provide for:

• An X-Windows Motif Toolkit Interface

• An API for use with C and C++

• An Interface for MS-Windows (two versions)

• An API for use with MS-Windows

• Browser Interfaces

The basic manuals cover the “basic product” and the X-Windows interfaces. Additional supplements cover
the other interfaces.

The basic manuals are:

• User Guide - a quick introduction and “cookbook” for use of GNUBatch.

• Reference manual - a complete description of all components of the basic product.

• Administrator Guide - information about installation and customisation of the software.

Also available are:

• API reference manual for Unix and MS-Windows API

• MS Visual C++ Windows Interface Manual)

• MS Windows Clients (PyQt version for newer Windows releases – this manual)

• Browser Interface Manual

This manual for the PyQt MS Windows Interface describes the facilities of the Windows interface only and
assumes knowledge of the basic product.
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Chapter 2

Installation

The GNUBatch PyQt Windows interface is provided as a collection of Python Source files. It can be run
on GNU/Linux using PyQT or it can be run on Windows with Python, PyQt and the Python Win 32 API
interface.

Before starting, we suggest that you first set up the Unix hosts as explained in the Administration Manual
according to whether the PCs have fixed IP addresses or are DHCP clients.

The copies of GNUBatch on the Unix hosts should be set up to be “networked”, i.e. so that jobs and
variables are shared across the network. It would be helpful if the local name services can resolve names
to the relevant IPs, but this is not essential.

Unlike the Visual C++ version, there are only two programs to be installed, btqw and btrw, not three, i.e.
there is no btrsetw. The facilities formerly provided by btrsetw are provided in btqw. However the other
functionalities of btqw and btrw are similar.

A key difference between the two versions of the MS Clients are that saved jobs are now held in a single
file in XML format rather than having a saved script and a separate job file.

2.1 Starting up

We suggest you start by running the btqw as the Python file btqw.py. You may need to resolve some
missing dependencies.

When first entered, the display will look like the following:
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To set up the servers, select the Server list item from the File menu.

The following dialog box should be displayed
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2.1.1 Setting the local address

The first task will be to set up to interrogate the local IP address. This is important in order to distinguish
references to the local machine (i.e. the Windows client) from other IP addresses. This is usually done by
making a connection to some web site and looking at the local address.

When first set up, the web site www.google.com is set up, but this can be changed to any other. When
ready, press the Set button to initialise the local address. If this runs satisfactorily, it will be used henceforth.
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2.1.2 Setting the server address

To set up one or more servers, click the New button, to receive the dialog box:

In the Host box put either the server name, if it is recognised by the domain name system, or else the
server IP address.

If the server is given as an IP address, put a suitable alias name, we suggest one or two characters, by
which the server will be referenced on all the windows and dialog boxes in btqw or btrw. You can also do
this to provide a convenient abbreviation for the server name if you wish.

You will usually want to indicate that you want the server to be connected every time you start up btqw, in
which case you should set the checkbox given, for example:

When done, press OK and the program returns to the previous dialog with the server details filled in, thus:
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If this looks correct, select the line by clicking on it and press the Connect button.

You will probably get a dialog like this:
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You may need to edit the login name (although the server may have been set to map Windows user names
to UNIX ones) and put your password in (although you can set a password for GNUBatch different from
your login password on the server if you want to using gbch-passwd).

After successfully logging in, quit from the server setup dialog and the exported jobs and variables should
appear on the two windows initially displayed.

Initially one job window and one variable window is displayed and you may want to move these apart and
resize them.
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The settings and the dimensions of the windows are saved when btqw is exited and restored next time.



Chapter 3

Overview

GNUBatch can run on a single Unix host or several co-operating machines. The Windows software can
manage the batch jobs on one or more of these Unix hosts. It can also submit new jobs to any other
host, with a default of one particular host, known as the Server. The Server is specified at the PC, hence
different PCs can use different Servers and each PC can change Server.

The program which manages jobs is called btqw and the program to submit jobs is called btrw. Their
relationship to a group of three Unix hosts might look like this:
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In this example, program btqw can see and manage jobs on hosts tom, dick and harry. Program btrw
submits new jobs by default to host tom.

3.1 Jobs & Variables

GNUBatch maintains a queue of batch jobs. Each batch job consists of a script and a specification of
what GNUBatch should do with it.

Job Control Variables are provided by GNUBatch to manage dependencies between jobs. Jobs can
include specifications to set or modify the values of variables when they start or finish. On finishing,
different operations can be specified for variables depending on whether the job worked or failed.

The job specification also includes conditions on variables, which GNUBatch tests before letting that job
start.
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3.2 Owners, Groups and Modes

Like Unix files, all jobs and variables are owned by a user and belong to a particular group. This is used to
say who may see and edit a job or variable. These work with the protection modes.

Each job and variable is given a protection mode. This consists of a set of permissions dictating how
various users may, or may not, access the job or variable. The modes are like those on Unix files, pro-
viding user, group and other access. An expanded set of permissions has been devised to enable the
permissions to control separate operations.

The modes of jobs and variables are set when they are created, however users authorised by the mode
may reset them subsequently.

In the case of jobs, the modes set by btrw are used, in default of which a set of default modes for the given
user are set.



Chapter 4

User Programs

There are two Programs which are installed on a Windows PC. The installation normally sets up a Program
group called GNUBatch Windows Interface in the Program Manager. The programs are described in
following chapters. Features that are common to more than one program, like the dialog for setting job
start times, are described in one chapter.

The two programs are:

Batch Queue Management Tool Shows the Queue of Batch Jobs and Set of Job
Control Variables, allowing users to change them according to the various permissions.
This program also provides initialisation facilities provided in the previous MS Windows
interface as btrsetw.

Job Creation Tool enables jobs to be specified and then submitted to the Batch Queue.
Jobs can also be “unqueued” using btqw, then changed and re-submitted using btrw.
Jobs can also be created and submitted from scratch.

15



Chapter 5

Btqw - Queue Management Tool

Btqw is a Microsoft Windows Client alternative to the standard batch queue manager, gbch-q. It is usually
invoked from the Windows Program Manager, or from the desktop by clicking on the Btqw icon shown
above.

5.1 The Main Window

When btqw is invoked the main window will be displayed, with a sub-window for jobs. By default it will look
something like this:
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The main window has two key functional areas. The top area contains menus and short cut buttons for
issuing commands. The larger, bottom area, holds the sub-windows for batch jobs and variables. These
may be selected to have commands performed upon them.

Like with other Windows applications the windows may be moved, resized, maximised and minimised.

Menu options allow the windows to be tiled horizontally and vertically or cascaded.

The widths of each column in each of the windows may be adjusted as required by dragging across
the border. Alternatively double-clicking on the border will fit the width of the column to the largest field
displayed.

The user can have any number of job and variable windows and specify different jobs or variables selected
by various criteria in each and also different attributes of the jobs and variables in each.

When btqw is exited, the current selections and sizes for each window are saved and are restored when it
is restarted.

If a menu option or button is “greyed out” it means that a suitable job or variable has not been selected. It
may be that the required item is selected but not the sub-window that contains it. Look at the “title bar” of
the sub-window to see if it is the “active window”.
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5.2 The Menus and Shortcut Buttons

All commands are performed by selecting a menu option or clicking on the equivalent shortcut button.
Some of the menu options may also be selected using shortcut keys, which are indicated to the right of
the relevant options in each menu.

Other options may be selected from a “right-click” popup menu from the appropriate place on a job or
variable window.

5.2.1 The File Menu

The file menu selects various global options, notably the server list.

Time defaults opens a dialog for setting default time and repeat specifications for jobs. This is separate
from the defaults used by btrw.

Program options brings up the Program options dialog, to tailor the look and feel of btqw.

Server list maintains the list of servers to which btqw and btrw communicate.

Port settings enables the TCP ports on which btqw and btrw communicate with the servers to be adjusted.

Quit quits btqw.

The following shortcut button is provided on the toolbar.

is a shortcut button for Program options.

5.2.2 The Window menu

For opening new job and variable list windows, changing the layout of windows and formatting their con-
tents.
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New Job Window opens a new window containing a Job List.

New Variable Window opens a new window containing a Variable List.

Window Options sets a filter to be applied to the currently-selected job or variable window to limit the jobs
or variables displayed to those matching given criteria. The filter set is saved and restored separately for
each window across btqw sessions.

Cascade, Tile Horizontally and Tile Vertically re-arrange the job and variable windows in standard ways.

Set list format Adjusts which attributes of each job or variable are to be displayed in the currently-selected
window. This information is saved across btqw sessions.

The following shortcut button is provided on the toolbar.

Is a shortcut button for Window Options

5.2.3 The Action Menu

For high level actions: starting and stopping batch jobs.

Set runnable will change a job from the Cancelled, Error or Abort state to the Ready or Run state. This
option is also available using the shortcut button.

Set cancelled puts a job on held (i.e. not able to run). This option is also available using the ‘Set cancelled’
shortcut button.

Force run sets a job runnable and overrides any time specification to allow the job to run as soon as any
Variable Conditions are satisfied. This option is also available using the ‘Force run’ shortcut button.
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Go job sets a job runnable overriding any time specification to allow the job to run as soon as any Variable
Conditions are satisfied. The repeat time on the job is advanced to the next repetition. This option is also
available using the ‘Go Job’ shortcut button.

Interrupt job attempts to terminate a running job by sending it an Interrupt Signal. This option is also
available using the ‘Interrupt job’ shortcut button and by clicking the right mouse button over the job to
select it and selecting “kill” from the pop-up menu.

Quit job tries to terminate a running job with a Quit Signal. This option is also available using the ‘Quit job’
shortcut button.

Other signal attempts to terminate a running job by sending it a specified Signal. This option opens a
selection dialog to choose which signal to send.

The following shortcut buttons are provided on the toolbar.

Is a shortcut for Set runnable

Is a shortcut for Set cancelled

Is a shortcut for Force run

Is a shortcut for Go job

Is a shortcut for Interrupt job

Is a shortcut for Quit job

5.2.4 Create/delete menu

This menu offers options for creating and deleting variables, deleting jobs and an option to invoke a copy
of btrw to create jobs (although you may prefer to invoke it via the desktop icon). It also offers options to
change job and variable permissions.

Depending on whether a job or variable window is selected, the inappropriate menu items are greyed out.
The version below is that applicable if a job window is selected.
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Create jobs invokes a copy of btrw.

Delete job deletes the currently-selected job. Depending on the setting of the delete confirmation option
in the Program Options dialog, confirmation may or may not be requested.

Job Permissions displays and provides options to set the permissions on the currently-selected job.

Create variable creates a new variable on a server.

Delete variable deletes the currently-selected variable.

Variable Permissions displays and provides options to set the permissions on the currently-selected
variable.

Unqueue removes the job from the queue, putting a copy on the PC hard disk possibly for editing and
re-submission using btrw.

Copy job takes a copy of the job from the queue, putting the copy on the PC hard disk possibly for editing
and re-submission using btrw. The original job is left on the queue unchanged.

The following shortcut button is provided on the toolbar.

Is a shortcut for Delete job

5.2.5 Jobs menu

This menu provides options for displaying and modifying attributes of jobs.

Note that the items here will be greyed out unless a job in a job window is selected.
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View job opens a text browser showing the job script to be run. This can also be selected by using the
‘View job’ shortcut button and by right-clicking the mouse over the job on the job list and selecting the
option from the pop-up menu.

Advance Time skips the next scheduled execution of a job by advancing to the next repetition. This option
is also available using the ‘Advance Time’ shortcut button.

Time brings up a dialog for setting the start time, retention options, repetition details and list of days to
avoid. This option is also available using the ‘Time’ shortcut button.

Title prio, load level brings up the dialog to set the job title, priority, load level and command interpreter.

Process parameters brings up the dialog to select the process parameters: working directory, ulimit,
umask, network scope and which exit codes represent an error.

Time limits opens the dialog for specifying time restrictions to terminate a runaway job.

Mail and write opens the dialog to specify what notification is required when a job finishes.

Arguments opens a dialog for adding, modifying and deleting arguments that are passed to the job on its
command line.

Environment opens a dialog for adding, editing and deleting the environment variables in the jobs run
time environment.

Redirections opens the dialog for specifying I/O redirections.

The following shortcut buttons are provided on the toolbar.
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Is a shortcut for View Job

Is a shortcut for Advance Time

Is a shortcut for Time.

Is a shortcut for Title Priority Load Level.

Is a shortcut for Process Parameters.

5.2.6 The Conditions Menu

Provides options for setting up pre-conditions and assignments.

Job conditions brings up the dialog to add, modify and delete pre-conditions on the selected batch job.

Job assignments brings up the dialog to add, modify and delete assignments for the selected batch job.

Both these options are available using the toolbar buttons shown. Additionally a job may be selected and
one these options set by right-clicking the mouse over the relevant job on the job list and selecting from
the pop-up menu.

The shortcut buttons are:

For Job Conditions

For Job Assignments

5.2.7 The Variables Menu

Provides options for manipulating variables.
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Assign brings up the dialog to modify the data held by the selected variable. This option is also available
on the tool-bar button and on the right-click pop-up menu.

Increment increments the value of the selected variable by the currently set constant. This option is also
available on the tool-bar button and on the right-click pop-up menu.

Decrement decrements the value of the selected variable by the currently set constant. This option is also
available on the tool-bar button and on the right-click pop-up menu.

Multiply multiplies the value of the selected variable by the currently set constant.

Divide divides the value of the selected variable by the currently set constant.

Remainder performs a modulo on the value of the selected variable by the currently set constant.

Set comment brings up the dialog to modify the comment field of the selected variable. This option is also
available on the right-click pop-up menu

Set constant for the increment, subtract, multiply, divide and remainder operations. This option is also
available on the right-click pop-up menu.

The following shortcut buttons are provided on the toolbar.

Is a shortcut for Assign

Is a shortcut for Increment

Is a shortcut for Decrement

5.2.8 The Search Menu

Both the variable and job lists may be navigated by using search options to find an item of interest.

Search for a specified item or pattern.
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Search forward from the current position

Search backward from the current position

5.2.9 Help

Help for using btqw.

About displays information, such as release number, about the version of btqw that is running.

5.2.10 Pop-up menus

Jobs and variables may be selected and various commonly-selected options applied by right-clicking on
the job or variable list, usually on the job or variable to be accessed. This will select the job or variable
clicked over and bring up pop-up menus.

For jobs the pop-up menu is as follows:

For variables the pop-up menu is as follows:

5.3 Dialogs

Much of the contents of the btqw dialog boxes are similar to those in other GNUBatch interfaces, however
for completeness some additional details and explanations are provided here.
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5.3.1 Program Options

The Program Options dialog in the File menu provides some options relating to the whole program.

5.3.1.1 Setting the Confirmation level

By default btqw asks for confirmation before deleting any job from the queue. This may be relaxed to allow
jobs to be deleted without confirmation if required by selecting the radio button.

Note that this applies to all windows.

5.3.1.2 Unqueue as binary

If this option is selected no conversions on MS Windows are done to insert carriage return characters in
front of linefeed characters when the job is unqueued.

5.3.1.3 UDP wait time

Certain operations (login and similar) are carried out by means of UDP messages. This option selects how
long a response will be awaited in each case.

5.3.2 Server list

The server list dialog was mentioned in the installation on page 8, and looks like this.
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The function of this dialog is to set up and maintain the list of servers running GNUBatch to which btqw
(and also btrw communicates and to possibly connect and disconnect them.

Particularly important is that the client can obtain its own address quickly and the usual convention is to
put a website which it can connect to and extract its own local IP address from there.

Alternatively a client can interrogate a server by selecting it and pressing the L.A. from server button.

The User Permissions button displays the permissions which the user has on the server, including the
user and group names assigned.
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5.4 Window Options

This dialog applies some options to the current window to curtail jobs or variables in which the user has
no interest. THe limitation applies until it is changed and is saved when btqw is quit. Initially no restrictions
are set.

The Job queue restriction applies to jobs, but the other restrictions apply to both jobs and variables.

Sets of queues, users or groups may contain just one name, a list of names or a list of patterns for matching
names. The group and user names may be given as a comma-separated list of alternatives, including the
use of shell-style wild-cards. For example

fred
jmc,tony,ukops_jmc,ukops_wal
ukops*,ukadmin[1-5]

The wild-card options are:

* Matches anything

? Matches one character

[a-m] Matches one character in list or range

[!n-z] Matches one character not in list or range

If only one explicit name is required, the drop-down combo box may be used to select it.

To remove all the restrictions quickly, press the button.
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5.5 Changing the fields displayed

If you want to change which attributes of jobs or variables are displayed in a given window, you can select
the menu entry Set list format in the Window menu.

For a job window with default settings, the following dialog is displayed.

The equivalent for a variable window is.
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Each row on the list of attributes corresponds to a column on the displayed window.

To add a new attribute to display, select it from the drop-down box at the top and click the Add button.

To delete an attribute, select it and press the Delete button.

The fields can be reordered by dragging and dropping.

The selected fields are specific to the window being displayed and are saved and restored for when btqw
is re-entered.

On the window display the column widths can be adjusted by dragging the borders. Double-clicking on the
border will set the width of the current column to the widest entry displayed. The widths are also saved
and restored across btqw sessions.



Chapter 6

Btrw - Job Submission & Editing Tool

Btrw can be used to create and edit saved job files on the PC hard disk and submit them to a server
running GNUBatch for execution.

Job files saved using the Unqueue command in btqw are in the same format as understood by btrw.

Unlike the Visual C++ version of the Windows clients, jobs are saved as a single XML file rather than a
command file and a job file.

Jobs may be submitted to any of the servers set up under the server list of btqw. The servers must be
online, but they need not be connected under btqw.

6.1 Mode of operation

Btrw displays a list of opened job files. This list is saved when btrw exits, and reloaded when it is restarted.

New jobs may be created with attributes set up from a list of default attributes which can be set up and
adjusted from a separate menu entry.

Any of the jobs may be selected, edited, saved and submitted to a server running GNUBatch.

6.2 The Main Window

When btrw is invoked for the first time the main window will be displayed, looking something like this:

31
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The main screen is divided into two key functional areas. The top area contains menus and short cut
buttons for issuing commands. The bottom is used to display a list of the job files which btrw currently has
open.

Wherever possible, Btrw uses similar windows and dialogs to btqw for specifying the job options.

To edit job scripts btrw has its own internal editor or it can invokes an editor of the user’s choice.

6.3 The Menus and Shortcut Buttons

All commands are performed by selecting a menu option or clicking on the equivalent shortcut button.
Some of the menu options may also be selected using shortcut keys, which are indicated to the right of
the relevant options in each menu.

6.3.1 File Menu

The file menu provides options for creating, opening and saving jobs and also for configuring btrw and
quitting.
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New Job creates a new job, using the current default settings (although you should be careful to set these
up first) ready for editing.

Open job opens a previously created job file. This might have been created by a previous run of btrw or
via the Unqueue command in btqw.

Save saves the currently-selected job and attributes to file, prompting for a file name and directory if
necessary.

Save As saves the currently-selected job and attributes to a new file.

Save All saves to file all the jobs which have been edited and have unsaved changes.

Close closes the currently-selected job file and removes it from the displayed list.

Close and Delete closes the currently-selected job file, removes it from the displayed list and also deletes
the file.

Program Options displays a dialog to modify the overall options used by btrw.

Quit exits the program.

The following shortcut buttons are provided on the toolbar.

Is a shortcut for New Job

Is a shortcut for Open Job

Is a shortcut for Save

6.3.2 The Defaults Menu

The defaults menu provides a set of preset options which are applied to all new jobs which are subse-
quently created.

It is probably a good idea to set up options appropriate to your environment before starting to create any
new jobs.
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(Note that default conditions and assignments are provided for on the Conditions menu.)

Set Cancelled (a tick appears next to it if this is selected) sets the cancelled state as the default for new
jobs.

Set time Sets a default set of time and repeat parameters (note that this is separate from the Time defaults
option in btqw).

Title priority load level Sets default values for title, priority, load level and command interpreter.

Process parameters Sets default values for the process parameters: working directory, ulimit, umask, exit
code ranges, advance time on error flag.

Time limits Sets default values for detecting and stopping over-running jobs.

Permissions Sets default values for job access modes (these are initialised to the user’s default values on
the default server).

Mail / Write Sets default values for the job completion flags.

Arguments Sets default values for job arguments.

Redirections Sets default values for job I/O redirections.

Environment Sets default values for environment variables.

6.3.3 Job Menu

The job menu provides options for setting various attributes of the currently-selected job file.
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Set runnable sets the job so that if submitted, it is ready to run immediately (if the conditions and time
constraints are met).

Set cancelled sets the job so that if submitted, it will be in “cancelled” state, i.e. held until set ready to run
by the operator.

Set time brings up a dialog to set the time and repeat options for the job.

Title, priority, load level brings up a dialog to set the title, priority, load level and command interpreter for
the job.

Process parameters brings up a dialog to set the process parameters i.e. working directory, umask,
ulimit, exit code ranges and export settings.

Time limits brings up a dialog to set the running time constraints for the job.

Permissions brings up a dialog to set the modes or access permissions for the job.

Mail/Write brings up a dialog to set the notification flags for the job.

Arguments brings up a dialog to set the arguments for the job.

Redirections brings up a dialog to set the I/O redirections for the job.

Environment brings up a dialog to set the environment for the job.

The following shortcut buttons are provided on the toolbar.

Set time

Title, priority, load level

Process parameters
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6.3.4 Conditions menu

The conditions menu provides options for setting conditions and assignments together with default sets of
conditions and assignments to apply to new jobs.

Conditions brings up a dialog to set or edit the conditions on the currently-selected job.

Assignments brings up a dialog to set or edit the assignments on the currently-selected job.

Default conditions brings up a dialog to set or edit the default conditions to be applied to any newly
created job.

Default assignments brings up a dialog to set or edit the default assignments to be applied to any newly
created job.

The following shortcut buttons are provided on the toolbar.

Is a shortcut for Conditions

Is a shortcut for Assignments

6.3.5 Submission Menu

This menu provides options for submission of jobs and for viewing and/or editing the job script.

View script displays the script of the job in a window. Any number of job scripts may be displayed in this
way.

Edit script creates an initial script if none is provided and displays it for editing. If the program option to
set an external editor is provided in program options (see page 33) then this is used, otherwise an internal
editor is used.

Submit locally submits the job to the queue on the server marked under the program options (see page
33) as the default server.

Submit remote prompts for a server and submits the job to the queue on that server. (Note that some of
the settings and permissions are assumed to be the same as those for the default server).
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The following shortcut buttons are provided on the toolbar.

Is a shortcut for View script

Is a shortcut for Edit script

Is a shortcut for Submit locally

6.3.6 The Help Menu

Help for using btrw.

About displays information, such as release number, about the version of btrw that is running.

6.3.7 Right-click menu

Right-clicking on a line on the btrw display brings up the following commonly-used options:

View Job Script displays the script of the selected job.

Edit Job Script brings up an editor window to edit the script of the selected job.

Submit job submits the job to the main server as selected under Program Options.

Title, priority, cmd int and Process parameters are equivalent to the corresponding menu selections on
the main menu.

Save job saves the job to file.

Set runnable and Set cancelled select the same options as for the job menu selections.
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6.4 Creating a New Job

Creating a new job is hopefully a lot easier than with the Visual C++ version of the Windows clients, notably
because only one file is used to hold the job and the job script.

This section is intended to give an overview of how this is done, all the way to submitting the job.

6.4.1 Checking program options

At least the first time you attempt to create a job, you should review the program options to select the
preferred server (from which default permissions will be taken).

Use the File - Program options menu item to get the dialog:

The first entry is the main server, where servers set up in btqw are listed. Select the required one using
the drop-down box.

Note that this server does not have to be one to which btqw usually communicates.

The Verbose checkbox is used to cause the job number of jobs successfully submitted to be displayed in
a pop-up box. Set this as required, but probably you will wish to.
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The External Editor selection allows you to edit job scripts other than with the internal editor. However we
do not particularly recommend this. It is mostly intended for use when the program is run on UNIX-style
systems.

6.4.2 Checking the default settings

At least the first time you attempt to create a job, you may probably want to review the default settings.

If you first select Defaults - Process parameters, the following dialog should be displayed.

The default working directory is initialised to /tmp. This should probably be changed to a more appropriate
working directory. Remember that environment variables and constructs of the form user/batchdir
are expanded here so you could put some appropriate generic construct in here.

Another aspect to consider is the export settings. By default this is set to local only, so that jobs are only
visible on the server itself. You may wish to set this to Exported so that the jobs created are at least visible
with btrw.

You may want to consider resetting some of the other options in the default section, perhaps by setting a
convenient prefix to titles to be adjusted later.
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6.4.3 Creating a new job

To actually create the new job, either select File - New Job, use the toolbar shortcut or use the
keyboard shortcut ctrl+N.

The new job is created, copying in initial values from the defaults, and the screen display should then look
like this:

The directory and file columns refer to the location on the Windows client, not to anything referred to in
the job, so these are empty to start with. If the job has a title, this is displayed in the relevant column. The
name of the command interpreter is also displayed.

The next 4 columns show the state of the job.

1. The first of these column shows whether a script has been created for the job. All jobs should have

a script. If the job has a script then is displayed, otherwise is displayed.

2. The second of the columns indicates whether the job will be submitted in “cancelled” state or ready
to run state.
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3. The third of the columns indicates whether the job has been submitted in its current form. It will be

if it has been and there are no changes since, otherwise it will be .

4. The final column indicates whether there are unsaved changes. If there are none (including a new

job identical to the default) then is displayed, otherwise .

Next perhaps give it a title by selecting the job and the menu entry Job - Title, priority, load level or the

button.

This should display a dialog such as the following:

Type in a title, perhaps Example and possibly adjust the command interpreter, priority and load level.

Note that a queue prefix may be automatically prepended to the title, with prefixes previously encountered
available from the drop-down box.

Note that the priority may only be adjusted between limits set for your user name. Likewise the load level
may be restricted to only that set for the command interpreter selected, in which case the buttons and
slider may be disabled.

The “round up” and “round down” buttons are used to adjust the load level to tidy multiples of ten.

After the title has been set and the OK button pressed the display should look like this:
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The icon on the end has changed to indicate that the job has unsaved changes and the title has been
inserted.

Next set up a script for the job by selecting Edit script.

This should bring up a window showing the job title and command interpreter name.

Scripts are assumed to be text files. Note that prefixes such as #! /bin/sh are not required.

When done, the icon in the “has script” column will be appropriately changed.

You may want to save the job at this point to a file on the PC. This brings up a standard Windows-style
save box. When done, the display will change to
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The directory and file names on the PC are filled in and the final column is changed to indicate that there
are no unsaved changes.

Finally submit the job to the main server by using the button or equivalents.

If all goes OK and the Verbose option was set in program options, the message:

The icon against the job will be changed to indicate that the job has been submitted on the main display.
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